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bben a hónapban tovább folytathat-
juk a GIMP csodálatos világával való
ismerkedést, amely még nekem is

szolgált meglepetéssel. E sorozat írása
közben ugyanis még ennyi idõ után is fede-
zek fel újdonságokat a programban. A má-
sik, szintén ide kivánkozó jó hír, hogy nem-
régiben jutottam hozzá a GIMP 2.0-ás válto-
zatához és örömmel láttam, hogy a scheme
parancsnyelv mellett már Python nyelven is
írhatjuk a kiegészítõ vagy munkánkat meg-
könnyítõ segédprogramokat. Ezekkel bõveb-
ben is megismerkedünk hamarosan, egyelõ-
re legyen annyi elegendõ, hogy mostantól
nem kell új programnyelvet megtanulnunk,
és mégis kihasználhatjuk a GIMP önmûködõ
képfeldolgozásra való képességét.
Nos, e könnyed bevezetõ után bizonyára
mindenki ráhangolódott a tanulásra, ismer-
kedjünk hát meg néhány hasznos menüponttal. Bizonyára
mindenkivel elõfordult már, hogy egy képrõl el kellett távo-
lítania a felesleges, üres részeket. Például valaki egy kicsit
nagyobbra jelölte a lapolvasó aktív területét, és emiatt olyan
fehér területek kerültek a beolvasott képre, amelyeknek
nincsen sem információtartalmuk, sem egyéb jelentõségük.
Ilyen esetekben lehet segítségünkre az Automatikus levágás
(Autocrop) és a Zealous Crop menüpont, amelyek megpró-
bálják ezeket a területeket megkeresni, és a képet méretre
vágják. Tapasztalatom szerint a második megoldás, vagyis
a Zealous Crop jobb végeredményt ad, ám lassabban mû-
ködik, ami egy gyorsaságot igénylõ munka esetén igen
hátrányos. 
Ezeket a kivágásokat a jobb egérgombbal a képre kattint-
va, a menüben érhetjük el, a Kép->Átalakítás (Image->
Transforms) pontokon keresztül.
Itt találhatunk még egy nagyon hasznos menüpontot, ami
a Guillotine néven található meg. A GIMP lehetõséget ad
arra, hogy függõleges és vízszintes segédvonalakat helyez-
zünk el a képen. Ennek használatához nyomjuk meg vala-
melyik vonalzó fölött a bal egérgombot, és húzzuk rá a kép-
re a segédvonalat. A felsõ vonalzóról lehet vízszintes segéd-
vonalat a képre helyezni, míg a bal oldaliról függõlegeset.

Amiért mindez érdekes számunkra, az az
imént említett menüpont. Ha ezt kiválaszt-
juk, akkor a GIMP a megadott segédvonalak
mentén feldarabolja a képet. Ennek gyakor-
lati hasznát remélhetõleg nem kell részletez-
ni ezért csak megemlítek párat: használhat-
juk arra, hogy a honlapunkon a nagyobb ké-
peket feldaraboljuk a táblázatos megjelení-
téshez, vagy arra, hogy amikor játékunkat
készítjük, akkor a különféle figurákat egy
képrõl több kisebbre helyezzük el.
Tulajdonképpen nem is kell megvárnunk,
amíg eltûnik ez a menü, máris folytathatjuk
a különféle átalakítások megismerését. Az
Eltolás (Offset) segítségével a képet eltolhat-
juk megadott mértékben. Ha a választó pár-
beszédablakban kiválasztjuk a Körbekerít
(Wrap around) kapcsolót, akkor a kép kilógó
részei az ellenkezõ oldalon visszatérnek, ha

viszont ezt nem kapcsoljuk be, akkor eltûnnek.
Természetesen a képet el is forgathatjuk, mégpedig elõre
megadatott kilencven fokos lépésekben a Forgatás (Rotate)
menüben található forgatási értékek kiválasztásával, vagy
az eszköztár segítségével. Az eszköztárban az 1-es képen
kékkel keretezett gombra kattintva az egérmutató megvál-
tozik és egy forgatásra utaló jelként jelenik meg. Ha ilyen-
kor a képre kattintunk, megjelenik egy négyzetrács, köze-
pén egy fekete pöttyel. A fekete pont adja meg a forgatás
középpontját és az egérgomb lenyomása közben mozgat-
va az egeret megadhatjuk az elforgatás szögét. Ugyanez-
zel az eszközzel lehetõségünk van átméretezésre, torzítás-
ra és perspektíva létrehozására is. Egy ilyen perspektivi-
kus átalakítás eredménye látható a 2-es képen. A különféle
átalakításokat úgy érhetjük el, hogy az eszköz gombjára
kettõt kattintva a felbukkanó (3-as képen látható) párbe-
szédablakban kiválasztjuk a megfelelõ átalakítást. Itt állít-
hatjuk be azt is, hogy az átalakítás során megjelenjen-e
a segítséget nyújtó négyzetháló, és hogy az eredményt
szeretnénk-e simítani. Ez utóbbi mûvelet fõként nagyítás-
kor (Scaling) lehet érdekes. Ilyenkor nem egyszerûen
többször jelenik meg a képpont, de a szomszédos képpon-
tok között átmenetek is keletkeznek. 

A GIMP és a színek (3. rész)
Harmadik részéhez érkezett a Gimp nevû programot bemutató sorozatunk. 
Az írás segítségével tovább ismerkedhetünk a rendszer rejtett értékeivel, 
és megtanulhatunk egy-két igen hasznos trükköt is.

1. kép A GIMP eszköztára
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Más lehetõségünk is van az eltolásra és az átméretezésre.
Az 1-es képen piros kerettel jelölt eszközzel tudjuk a képet
vagy annak valamely rétegét eltolni, míg átméretezni a me-
nüben az Kép->Kép átméretezése (Image->Scale) Image me-
nüpontokat kiválasztva lehetséges. Miután az említett esz-
közzel eltoltuk a képet, célszerû a Rétegek->Réteg kép
méretûvé (Layer->Layer to imagesize) menüpontok kivá-
lasztásával a réteg méretét a képmérethez igazítani. Az
elõbbi menüben találjuk meg a rajzvá-
szon átméretezésére szolgáló menü-
pontot is, mégpedig a Kép->Rajz-
vászon mérete (Image->Canvas) size
pontok kiválasztásával. Ez a szolgálta-
tás akkor lehet hasznos, ha valamilyen
kép mellé szeretnénk elhelyezni egy
másikat, vagy hozzárajzolnánk más
formákat. Így készült például a 2-es
képen látható átalakított útdarabka is.
Maradjunk még egy kis ideig a Kép
(Image) menü tárgyalásánál. Itt talál-
hatunk ugyanis két nagyon fontos
eszközt. Az egyik a kép színmélységé-
nek változtatására szolgál, ezt a Mode
almenüben találhatjuk meg. Itt alakít-
hatjuk át a képeinket szürkeárnyala-
tosra, vagy korlátozott színekbõl
összeálló képpé. Fontossága abban rejlik, hogy a GIMP
a legtöbb szûrést és a bonyolultabb mûveleteket csak RGB
színekkel rendelkezõ képeken tudja elvégezni. Tehát ha
nem ilyen a feldolgozandó kép – például a GIF formátumú
képek maximálisan 256 színt használhatnak –, akkor elõször
át kell alakítanunk. Ez az átalakítás akkor is jól jöhet, ami-
kor olyan megjelenítõ-eszközünk van, ami nem képes sok
szín leképezésére. Ha ilyen eszközökön (régebbi mobilok,
játékkonzolok) szeretnénk megjeleníteni a képeket, akkor
felhasználás elõtt a át kell azokat alakítani.
A másik fontos menüpont tulajdonképpen kéttõ darab
menüpont. Az egyik a Összevonás (Compose), míg a másik
a Felbontás (Decompose). Ez utóbbival tudjuk az elkészült ké-
peket színrétegekre bontani, vagyis a nyomdai elõkészítés-
hez alkalmas formátumra alakítani. Itt választhatunk RGB,
HSV, CMYK, CMY színtereket, vagy ha a képnek van átlát-
szóság csatornája (Alpha channel) akkor szintén ezzel a mû-
velettel juthatunk hozzá. A Összevonás (Compose) menüpont
alkalmas az elõbbi mûvelet megfordítására. A megadott ké-
peket színcsatornaként értelmezve összeállítja az eredeti ké-

pet. A képhez az Alpha menü segítségével adhatunk átlátszó-
ságot szabályozó színcsatornát. Sajnos, tapasztalatom szerint,
ezt csak úgy tudjuk szerkeszteni, hogy a képet szétválasztjuk
csatornáira, majd az alfa csatorna szerkesztése után újra
összeállítjuk.
Egy nagyon hasznos lehetõséget szeretnék még bemutatni
a programmal kapcsolatban, ami nélkül ma már egy mo-
dern pixelgrafikai program szinte elképzelhetetlen. A GIMP

lehetõséget biztosít a felhasználónak
arra, hogy a teljes grafikát egymás fe-
lett elhelyezkedõ fóliákból állítsa
össze. Ezeket a fóliákat a szaknyelv
rétegeknek (Layer) nevezi. A rétegek
használatának szintén sok felhaszná-
lási lehetõsége adódhat, gondoljunk
csak arra, hogy egy képbõl kivágott
részletet szeretnénk egy másikon el-
helyezni. Ilyenkor a kivágott képrész-
letet külön rétegen helyezzük el, majd
a helyzetének pontos beállítása után
hozzákapcsolhatjuk az alatta lévõ ré-
teghez. A GIMP-ben a rétegek kezelé-
sére szolgáló párbeszédablakot
a CTRL-L billentyûkkel érhetjük el.
A párbeszédablak legnagyobb részét
a rétegek megjelenítése foglalja el.

Minden egyes tételnek külön nevet adhatunk, ha kettõt kat-
tintunk rá. Az elsõ (legalsó) réteg a háttér, ennek az a külön-
leges tulajdonsága, hogy nem adhatunk hozzá a megjelenést
szabályozó maszkot és nem helyezhetjük más rétegek fölé.
Háttér rétege minden képnek van, azonban a háttérnek is
megadható átlátszóság, aminek akkor láthatjuk hasznát, ha
a honlapunkon átlátszó PNG vagy GIF képeket használunk. 
A 4-es képen látható egy kép és a rétegeket megjelenítõ pár-
beszédablak, amelyhez több réteget használtam. A rétegeket
úgy tehetjük aktívvá, hogy a nevükre kattintunk az egérrel.
Így a szûrõk és a rajzoló mûveletek is a kiválasztott rétegen
érvényesülnek. Minden réteg neve mellett megjelenik egy
elõnézeti kép és egy szem, már ha a réteg látható. A képen
piros kerettel jelzett gomb segítségével adhatunk új rétege-
ket a képhez, ezek átlátszóságát pedig a kék kerettel jelölt
csúszkával állíthatjuk. A zölddel keretezett gombok alkalma-
sak a kijelölt réteg sorrendjének megváltoztatására. Ezek
mellett találhatjuk a következõket: réteg kétszerezése, réteg
csatolása az alatta lévõhöz és a réteg törlésére szolgáló sze-
metes. A rétegek csatolására szolgáló gomb olyan esetekben

2. kép Perspektívikus átalakítás

3. kép Átalakítás beállításai

4. kép A réteg-kezelõ
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alkalmazható, amikor valamilyen más
elemet illesztettünk a képre vagy arról
kiválasztottunk egy részletet.
Még mielõtt valakinek a használat során
kellemetlenséget okozna a nem megfele-
lõ fájlformátum kiválasztása, el kell mon-
danom, hogy a GIMP a rétegeket csak
a saját formátumában mentve képes
megõrizni. Ez a formátum az XCF, és
amikor a képet mentjük, elegendõ a ki-
terjesztésként megadni, nem kell feltétle-
nül kiválasztanunk a legördülõ listából.
Most már tudjuk, hogy az egyes rétegek-
nek megadhatunk átlátszóságot, itt az
ideje hát, hogy megismerkedjünk a to-
vábbi lehetõségekkel is. Minden réteg-
nek megadható, hogy milyen kapcsolatban legyen az alatta
lévõkkel, azaz milyen mûveletet végezzen a program a réte-
gek képpontjai között. Itt csak néhány lehetõséget mutatnék
be, hiszen minden mûveletet minden kombinációban meg-
mutatni gyakorlatilag lehetetlen ilyen szûkre szabott keretek
között. Az adott mûveletet az átlátszóságot meghatározó
csúszka felett található legördülõ listában választhatjuk ki.
Ezek közül a Kivonás (Subtract) azt jelenti, hogy az adott ré-
teg képpontértékeit a program kivonja az alatta lévõ kép-
pontokból, az Összegzés (Addition) pedig a képpontok között
végez összeadást. Érdekes még a Érték (Value), amelynek al-
kalmazásakor csak az adott réteg világosság-értékeit veszi fi-
gyelembe a program a végsõ kép meghatározásakor. Mind-
ezen mûveletek kombinálása legyen az olvasó feladata,
ugyanis valószínûleg szórakoztató és izgalmas kihívást talál
benne minden a kreatívitást kedvelõ felhasználó.
És akkor most térjünk át a rétegek menüpontjaira. Ha egy
rétegre a jobb egérgombbal kattintunk, akkor egy menüt
láthatunk, amiben fontos mûveleteket végezhetünk az
adott réteggel. Az elsõ öt menüpontot nem kell külön ma-
gyaráznom, mert hatásukban megegyeznek a párbeszédab-
lak alsó részén található gombokkal. A következõ a Réteg
határvonal mérete (Layer boundary size), amellyel meghatá-
rozhatjuk, hogy az adott rétegnek mekkora részét vegye fi-
gyelembe a program a mûveletek végzésekor, míg a Réteg
kép méretûre (Layer to Imagesize) arra való, hogy a kijelölt
réteg méretét a képmérethez igazítsa. A következõ a Réteg
átméretezése (Scale Layer) ami megegyezik a kép átmérete-
zésével, csak ebben az esetben kizárólag a kijelölt rétegre
vonatkozik. Természetesen a rétegeket egyesíthetjük is,
mégpedig a következõ menüpontok segítségével. A Látható
rétegek összefésülése (Merge visible layers) az éppen látható
rétegeket egyesíti. A réteg láthatósága az elõtte lévõ „szem”
ikon alapján állapítható meg. Ez az egyesítési mûvelet ak-
kor lehet hasznos, amikor úgy gondoljuk, hogy a kép egy
részével már elégedettek vagyunk, például már pontosan
a helyén van a beillesztett képdarabka. Ekkor egyesítjük
a hozzá tartozó réteggel és a továbbiakban nem kell fog-
nunk a fejünket, ha egy szûrõt mondjuk csak az összetarto-
zó rétegek egyikére alkalmaztunk.
A Összefésülés lefelé (Merge Down) menüpont hasonlóan
mûködik az elõbbihez, de itt csak közvetlenül a kijelölt réteg
és az alatta lévõ egyesítése történik. A Egy réteggé lapítás
(Flatten Image) menüpont kiválasztásával érhetjük el a kép

minden rétegének egyesítését. Ha vala-
mi olyan formában mentjük a képet,
ami nem támogatja a rétegeket, akkor
a GIMP maga is felkínálja, hogy egyesíti
a rétegeket, és ilyenkor célszerû ezt en-
gedélyezni, hiszen ha ezt nem tesszük
meg, akkor csak az éppen kiválasztott
réteget fogja menteni a program. Az ez-
után következõ három menüpont a réte-
gek maszkolására használatos. A réteg-
maszkot úgy kell elképzelni, hogy az
ezen található világosságértékek hatá-
rozzák meg, hogy a rétegnek ez a része
mennyire látható. Ha ez az érték 0 (feke-
te), akkor a hozzá tartozó képpont átlát-
szó, ha 255-ös (fehér), akkor a képpont

teljesen látható. Természetesen nem csak ez a két érték hasz-
nálható. Tehát a maszkot elõször is létre kell hozni. Ezt
a Rétegmaszk hozzáadása (Add Layer Mask) menüpont vá-
lasztásával tehetjük meg, majd meg kell adnunk, hogy kez-
detben a maszk milyen legyen. Lehet teljesen átlátszó, telje-
sen átlátszatlan és használhatjuk a réteg meglévõ alfa csator-
náját is. A maszkról is készül elõnézeti kép, amit a létrehozás
után láthatunk is a rétegkezelõ párbeszédablakban. Amikor
a maszkkal elkészültünk, a réteghez véglegesen hozzáren-
delhetjük a Rétegmaszk érvényesítése (Apply layer mask)
menüpont kiválasztásával. Azt azonban tudnunk kell, hogy
a maszkot hogyan szerkeszthetjük. A réteg kiválasztása után
kattintsunk a hozzá tartozó maszk elõnézeti képére. Ezt kö-
vetõen a képszerkesztõ mûveletek mindaddig a maszkra vo-
natkoznak, amíg a képet nem választjuk ki újra. Mielõtt még
ezt a végleges hozzárendelést elvégeznénk, lehetõségünk
van a rétegmaszk törlésére is a Rétegmaszk törlése (Delete
Layer Mask) menüpont választásával. Az utolsó menüpont,
amivel a maszkot kezelhetjük, egy igen hasznos mûvelet. Ez
a Maszk kijelöléssé alakítása (Mask to Selection) amivel kivá-
laszthatjuk a maszknak megfelelõ formát.
Most pedig néhány ötletet szeretnék adni, hogy megjöjjön
a kedves olvasó kísérletezõ kedve. Tegyük fel, hogy egy
almát kell elhelyeznünk egy már meglévõ tálba. Az almát
ekkor egy másik képrõl kijelöljük, majd a tálat tartalmazó
képre illesztjük. Elhelyezzük a tálban, de sajnos azt kell lát-
nunk, hogy a tál széle nem takarja el az almát. A kép olyan,
mintha az alma a tál elõtt lenne az asztalon. Ekkor segíthet
például a maszkolás. Az almát külön rétegre helyezzük,
a takart részt pedig maszkkal takarjuk el. Ezután már csak
az árnyékokat kell egy kicsit átrajzolni, a tálban az alma
árnyékát megfesteni és nagy vonalakban készen is van a tál
feltöltése. Természetesen ezt a feladatot megoldhattuk vol-
na úgy is, hogy a felesleges részeket egyszerûen letöröljük,
ekkor azonban az almának az örökkévalóságig ugyanabban
a magasságban kellene maradnia, nem helyezhetnénk fel-
jebb, mert akkor nem lenne teljes a kép. A fenti módszerrel
például kedvenc portrénkat is keretbe helyezhetjük, aho-
gyan az 5-ös képen látható, most azonban búcsúzom ked-
ves olvasóimtól, remélhetõleg mindenkinek hasznos idõtöl-
tést jelent a program használata és ha segítségre van szük-
ség, az eddigi ismert e-mail címemen várom a kérdéseket.

Fábián Zoltán

5. kép Portré
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